1 Preparation of environment
Before everything else please open our project in your Java Integrated Development
Environment:

1.1 Available instructions:

eclipse | 8intelliJ IDEA

1.1.1 Configuration in Intelli]:
This tutorial step by step is how to import existing eclipse's project to IntelliJ, so if You know how to
import, skip until section Exercise 0.

Let's run IntelliJ:

glntellu IDEA

2. Let's unpack our package
3. Import Project

@ Welcome to Intelli DEA

IntelliJ IDEA

a. If somebody does not see that window importing can be selected: File->New-
>Project from Existing Sources:

JADE - exercise_students_1_Intelli) [EADropbox\DOKTORANCKIE\jade_2017nal18\Jade_eng\JAC
Juild Run T
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4. Choose path to unpacked project (it is possible to paste path to project), then OK:

) Select File or Directory to Import

Select directory with existing sources,

Eclipse project (.project) or classpath (.classpath) file,
Maven project file (pom.xml),

Gradle build script (*.gradle).

" S @

»ADOKTORANCKIE\jade_2017nal8\Jade_eng\JADE - exercise_students_1
> DOKTORAT
> jade
v jade_2017nal8
> JADE
v Jade_eng
JADE - cwiczenia
JADE - exercise
JADE - exercise students_1
JADE - exercise students 2
zajecial
Jade_exercise_1.zip

Jade_exercise_2.zip

¢ TutorialJADE_ang.docx
¢ TutorialJADE_ang_Intelli).docx

e TutorialJADE_ang_lab2.docx

Cancel
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5. Choose "Import project from external model" and choose Eclipse, then Next:

Cancel

6. In window "Select Eclipse projects directory" You can press just Next, or change something.
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7. You should see project:

v JADE - exercise

ture after import

Cancel

select "Open Project Structure after import", then Next
8. In window "Choose project code style" You can press just Next, or change something.
9. In next window You probably will see possibility with selecting JDK, just press Finish.
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1.1.2 Running application in Intelli]:
1. Choose Run -> Edit Configurations...

Navigate Code Analyze Refactor Build [Run Tools VCS Window Help

JADE - exercise students 1 IntelliJ Configuration...

Project ~ = & —

> JADE - exercise_students_1_Intelli) Alt+Shift+F10

I 1: Project

» Il External Libraries Alt+Shift+F9

s1oafold UsneiN jo

Scratches and Consoles % Profile...
& Attach to Process... Ctrl+Alt+F5
L‘ Edit Configurations...
¥ Import Test Results

pINg 1LY B

- 2: Favorites

7 Structure

Q Event Log

IO Open edit Run/Debug configurations dialog

2. Inanew window press +, then choose Application, and type in Main class and Program

arguments what You see below:
-l;—Run

+ - B }' : | Run Jade| Share Single instance only

¥ lm Application
Run Jade Configuration Code Coverage Logs
L] un Jade

> F Templates Main class: jade.Boot

VM options:

Program arguments: —gui

Working directory: E\Dropbox\DOKTORANCKIE\jade_2017nal8\Jade_eng\JADE - exercise_students_1 Intell) | v
Environment variables:

Use classpath of module: JADE - exercise

Include dependencies with "Provided" scope

JRE: Default

Shorten command line: user-local default: none

Enable capturing form snapshots

¥ Before launch: Build,
+

Build
Show this page v Activate tool window

Cancel

3. Press Run.
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4. When we will have problems with port we would have to use another port with argument: -
host 192.168.2.9 -port 12344

5. In other problems it can help if we download newest version of JADE framework:

http://jade.tilab.com/download/jade/

1.1.3 Configuration in Eclipse:
1. Let's run Eclipse:

= eclipse

2. Let's unpack our package

3. File ->Import

-
& eclipse-workspace - Eclipse

Edit Source Refactor Mavigate

Search Project Run  Window Help

(i)

[

G E

MNew

Open File...

Open Projects from File System...

Close

Close All

Save
Save As...
Save All
Revert
Move...
Rename...
Refresh

Convert Line Delimiters To
Print...

Import...
Export...
Properties

Switch Workspace
Restart
Exit

Alt+Shift+M »

Ctrl+W
Ctrl+Shift+W

Ctrl+5

Ctrl+5hift+5

F5

Ctrl+P

Alt+Enter

§ @ ®ini]

<
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4. General -> Existing Project into Workspace -> Next:

[ = Import - @&uw

Select

Create new projects from an archive file or directory. @

Select an import wizard:

| type filter text |

4 [= General
& Archive File
|22 Existing Projects into Workspace |
[ File System
[ Preferences
[} Projects from Folder or Archive
= Git
[ = Gradle
[ [= Install
[ = Maven
[ = Comph
[ [= Run/Debug
[+ [= Tasks |

[ = Team
r o WAl

[ »

m

@ < Back Next > Finish
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5. Browse button, in which we have to choose path of our unpacked archive and project, after

that press Finish:

-
2 Import

Import Projects
Select a directory to search for existing Eclipse projects.

(@ Select root directory:
(71 Select archive file:

Projects:

Browse...

JADE - cwiczenia (Ch\Users\Mysko | Grzesko'\Desktop'jade_rozpakowane\JADE - exercise)

Select All

Deselect All

i

Refresh

Options

[ Search for nested projects

[ Copy projects into workspace

[ Hide projects that already exist in the workspace

Working sets
[] Add project to working sets

Wiorking sets:

Select...

Ned> ||

Finish

I [ Cancel
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6. After that we should see project with four packages:

& st sape

| Eile Edit Source Refactor MNavigate Search Project Run  Window Help
I R R I R R R IR T AN TR R R R
f Package Explorer 53 =) | @ - = O
4 ‘}:;,-‘J JADE - cwiczenia
a4 [ src
4 |F3 kis.sspd.jade.exercised|
i [J] HelloWorld,java
i [J] HelloWorld2.java
a H} kissspdjade.exercisel
i [J] Forgetfuljava
i+ [J] Listenerjava
 [J] Talkerjava
a B} kis.sspdjade.exercise2
&[] Ping.java
& [J] PingPong.java
& [J] Pong.java
a H} kissspdjadefarm
i [J] Breederjava
i+ [J] BunnyFernale java
= [J] BunnyMalejava
b [J] Wolf java
[» B JRE System Library [JavaSE-1.7]
|- =i, Referenced Libraries
4 [= lib
> [= commons-codec
APDescription.tt
2| jadejar
MTPs-Main-Container.txt
4 [= lib_old
[ [= commons-codec
APDescription.bdt
] jadejar
! MTPs-Main-Container.bd
APDescription.tst
MTPs-Main-Container.tet
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2.1.1 Running application in Eclipse
Let's try to run project, if you see any problems please check:

1. if all libraries are properly added:
a. Project ->Properties

,

| File Edit Source Refactor Mavigate Search IPloject Run Window Help

Eﬁvﬂhgtﬁ;vonvafﬁt Clr.lenF'rl:leCt gi}vf::l(:jvc'l)v
Close Project
£ Package Explorer 57 Cn:::'p | Y !
a |-:;_‘JJ JADE - cwinzenia| o Build All Ctrl+B
4 [ src Build Project
4 £ kis.sspd.jade.exercisel Build Working Set b

b [J] HelloWorld java

b [J] HelloWorld2.java
4 £ kis.sspd jade.exercisel

i+ [J] Forgetfuljava

i [J] Listenerjava

i [J] Talkerjava Properties

Clean...

v Build Automatically

Generate Javadoc...

Fl

4 £ kis.sspd.jade.exercised
i [J] Ping.java
i [J] PingPong.java
i [J] Pong.java
4 £ kis.sspd.jadefarm
i+ [J] Breederjava
i [J] BunnyFemale java
¢ [J] BunnyMalejava
b [J] Wolfjava
[» Eh JRE Systern Library [JavaSE-1.7]
[ =, Referenced Libraries
4 [= lib
[+ = commons-codec
APDescription.tet
& jadejar
MTPs-Main-Container.bet
4 [= lib_cld
[+ [ commons-codec
APDescription.bet
| jade.jar
I MTPs-Main-Container.bet
APDescription.tet
MTPs-Main-Container.tet
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b. Java Build Path ->Libraries:

-
= Properties for JADE - cwiczenia E‘E‘g
type filter text Java Build Path Py

|» Resource — -
Builders | (® Source | 1= Projects | @i Libraries | %, Order and Export
Coverage JARs and class folders on the build path:
|dmsom, Bl Bt p (w9 commons-codec-1.3jar - JADE - cwiczenia/lib/commons-codec [ Add JARs... ]
b Java Code Style b [ jade.jar - JADE - cwiczenia/lib
b ja"‘a E;’_mp"er » @ JRE System Library [JavaSE-1.7] | Add External JARs... |
[» Java Editor
Javadoc Location [ Add Variable... ]
Project References -
Add Library...
Refactoring History [ — ]
Run/Debug Settings [ Add Class Folder... ]
|» Task Repository
Task Tags | Add External Class Folder..|
[ Validation
Wiki Text Edit...
Remove
Migrate JAR File...
Apply
@ I.Apply and Close] [ Cancel ]

c. If we don't have those libraries we have to add them manually
2. Our running configuration and program arguments are correct:
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a. Run->Run Configurations ...

S st oo s

'| File Edit Source Refactor Mavigate Search  Project [Run| Window Help

N0~ Q- Q- @FigQ Ru Cerl+FL1

Debu F11
[ Package Explorer 23 =1 | ¢ T - f% J .
=, Coverage Last Launched Ctrl+Shift+F11
4 = JADE - cwiczenial
a [ src Run History J
4 ff kissspd.jade.exercisel Run As »

[ m HelloWoerld.java
b [J] HelloWorld2 java
2 7 kis.sspd.jade.exercisel Debug History »

i [J] Forgetful java Debug As '
i [J] Listener.java

b [J] Talkerjava

Run Cenfigurations...

Debug Configurations..,

4 7 kis.sspd.jade.exercise? Coverage History »
b P!ng.Java _ Coverage As b
i [J] PingPeng.java
» [) Pong.java Coverage...

4 7 kis.sspd.jadefarm Toggle Breakpoint Ctrl+Shift+E

i [J] Breederjava Toaale T -
i [J] BunnyFemale.java ©gge Tracepoin

i [J] BunnyMalejava @ Toggle Line Breakpoint
o [J] Wolfjava =+ Toggle Watchpoint
t» Hh JRE Systern Library [JavaSE-1.7] o Toggle Method Breakpoint

- =, Referenced Libraries

. ®,  Skip All Breakpoints Ctrl+Alt+B
4 = lib .
b B> commons-codec &% Remove All Breakpoints
APDescription.bdt Jg Add Java Exception Breakpoint..,
2| jadejar (® Add Class Load Breakpoint...
MTPs-Main-Container.td
4 = lib_old 3 All References...
[+ [ commons-codec All Instances... Ctrl+Shift+ M
APDescription.tt Instance Count...
[£] jade jar , ) Watch
MTPs-Main-Containertd _
APDescription.bet Inspect Ctrl+Shift+I
MTPs-Main-Container.be Display Ctrl+Shift+D
| | Execute Ctrl+L
Force Return Alt+Shift+F
G, Edernal Tools »
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b. Java Application ->New, main class should be jade.Boot

-
% Run Configurations

Create, manage, and run configurations @

Run a Java application

n [T !
L1 BE ® | = }P M Mame: MNew_configuration
type filter text © Main™_po- Argumentﬂ B JREW L Classpatlﬂ Ep Source\l -} Environmenf] 5] gommoﬂ
& Gradle Project Project:

lava Applet

a2 Java Application cwiezenia Browse
MNew_configuration Main class:

Ju JUnit jade.Booﬂ Search...

i Launch Group

m2 Maven Build [T]Include system libraries when searching for a main class
Juj Task Context Test [T]Include inherited mains when searching for a main class
[F] Stop in main

| Revet || Apply |

Filter matched & of 8 items

@ [ Run || Close |

A

c. Arguments ->Program arguments, we need to add -gui:

==

-
£ Run Configurations

Create, manage, and run configurations
Run a Java application @
& Jes b - . .
L1 B x | H 5@ Mame: New_configuration
type filter text © Main [0a= Arguments g, JREW & Classpatlﬂ Bs Source\l B Environmenﬂ = Qommoﬂ
& Gradle Project Program arguments: i

Java Applet i
4 lava Application
Mew_cenfiguration
Ju JUnit -
2 Launch Group
m2 Maven Build VM arguments:
Juy Task Context Test E

-gui

-

m

-

Variables... 2

l Rewvert ] [ Apply l

Filter matched & of & iterms

@ [ Bun ] [ Close ]

b

We can also set some name different than New_configuration
e. When we will have problems with port we would have to use another port with
argument: -host 192.168.2.9 -port 12344
3. In other problems it can help if we download newest version of JADE framework:

http://jade.tilab.com/download/jade/
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2 Exercise 0

2.1 The JADE Environment

What is JADE? JADE (Java Agent DEvelopment Framework) is a software Framework fully
implemented in the Java language. It simplifies the implementation of multi-agent systems through a
middle-ware that complies with the FIPA specifications and through a set of graphical tools that
support the debugging and deployment phases. It includes:

1. Aruntime environment where JADE agents can “live” and that must be active on a given
host before one or more agents can be executed on that host.

2. Alibrary of classes that programmers have to/can use (directly or by specializing them)
to develop their agents.

3. Asuite of graphical tools that allows administrating and monitoring the activity of
running agents.

2.1.1 JADE GUI:
If everything is OK program's named RMA window should appear, after full expanding of
AgentPlatforms we will see "Main-Container" directory:

h
) rma@192.168.0.149:1009/JADE - JADE Remote Agent Managem_ E=EER

File Actions Tools Remote Plaiforms Help

BIEIEEEEE B8 So s
7 B0 AgentPlatforms name addresses state owner
¢ £1"92.168.0.149:1099/JADE" NAME ADDRESSES STATE OWNER

¢ @@ Main-Container
ams@192.165.0.149:1099/JADE
dfi@192.168.0.149:1099/JADE
ma@192.168.0.149:1099/JADE
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http://jade.tilab.com/images/JADEscreenshot.jpg

e Forsingle JVM is connected single agent platform by default. Newly added agents are added
to already existing platform. At the picture below we can see Containers and Platforms:

@

Main container
: ! x,
1 "1 Is regiztered
'u.rh‘J:LP P .
Container 2 Platform 1 Contaimer 1
T
Metwork

Miain container

Platform 2

e RMA is not agent platform. In order to close JADE (e.g. for recompiling purpose) in RMA we
have to click File ->Shut down Agent Platform. If we close RMA without closing platform we
have to manually kill processes from Eclipse.

r
‘o rma®192.168.0.149:1009/JADE - JADE Remote Agent Management GUI
g

Fle| Actions Tools Remote Plaiforms Help

e |/ [a[a] (@@ (381 SwE o

Exit this Container

Shutd Agent Platform : name addresses state owner
T toe ouw- == 1099/ JADE" lams@192.168... |hitp:/Pofelkowy.... |active MOME

¢ B3 Main-Container
E ams@192 168.0.149:1009/JADE
= di@192.168.0.149:1099/JADE

= rma@192.168.0.149:1099/JADE
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e Each running instance of the JADE runtime environment is called a Container as it can
contain several agents. The set of active containers is called a Platform. A single special Main
container must always be active in a platform and all other containers register with it as soon
as they start. It follows that the first container to start in a platform must be a main container
while all other containers must be “normal” (i.e. non-main) containers and must “be told”
where to find (host and port) their main container (i.e. the main container to register with).

e After running the platform we can see 3 already running agents:

o The RMA (Remote Monitoring Agent) allows controlling the life cycle of the agent
platform and of all the registered agents. The distributed architecture of JADE allows
also remote controlling, where the GUI is used to control the execution of agents and
their life cycle from a remote host.

o The AMS (Agent Management System) that provides the naming service (i.e. ensures
that each agent in the platform has a unique name) and represents the authority in
the platform (for instance it is possible to create/kill agents on remote containers by
requesting that to the AMS).

o The DF (Directory Facilitator) that provides a Yellow Pages service by means of which
an agent can find other agents providing the services he requires in order to achieve

his goals.
Al: - serviceX
Al > - serviceY » Ad
. AZ2: = servicel
Publish . .
srovid Search for
‘ovide . .
I . A3: - serviceW equired
SCLVICCS - sartdce .
.,nrmTl.nf{ ser
- serviceH
Yellow Pages service

Exploit required
service

Please spend few minutes to explore RMA, because we are going to use its during rest of the day.
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2.2 Hello word

After selecting "Main-Container" please clik Actions ->Start New Agents in order to create new agent:

o rma S 0. 5 = emote Agent Management
@192.168.0.149:1009/JADE - JADE R Agent Manag GUI

= [ Bl [ |

File Action5|TO0Is Remote Platforms Help

[ [ Start New Agent
= B Kin
q EJ' Suspend

Ef Resume

@ Send Message
g:, Migrate Agent
Clone Agent

Jooe

D99/JADE"

1668.0.149:1099/JADE
6.0.149:1099/JADE
168.0.149:1099/JADE

& Load Agent
Save Agent

@ Freeze Agent
E Thaw Agent

& 9@ B8 8@ &

name |

addresses state

owner

Then we have to type Agent name and choose agent's class name, in order to choose class we should
click ... then select kis.sspd.jade.exercise0.HelloWorld, after that we can create the agent by clicking

OK.

e What happened?
o What the agent is doing?
e What can we see in console?

e Let's kill our running agent (Actions ->Kill), what can we observe?

e Isit possible to kill one of 3 default agents?

e s it possible to kill main container?

e Can we create multiple agents with the same name?
o Let's look to the HelloWorld agent's code.

2.3 Hello word2
Please run agent HelloWorld2

e What do we see in console just after creating the agent? What do we see after few seconds?

o Let's try to kill the agent manually
e Let's look to the HelloWorld agent's code.

Class Agent and all derived classes inherit few methods, e.g.:

Method Description Return value
setup() This protected method is an empty void
placeholder for application specific
startup code.
takeDown () This protected method is an empty void
placeholder for application specific
cleanup code.
doDelete() Make a state transition from active, void
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suspended or waiting to deleted state
within Agent Platform Life Cycle,
thereby destroying the agent.

addBehaviour(Behaviour b)

This method adds a new behaviour to the | void
agent.

More information in reference: http://jade.tilab.com/doc/api/index.html

3. Exercise 1

3.1 Agent behaviour and lifecycle - Forgetful
The actual job an agent has to do is typically carried out within “behaviours”. A behaviour represents

a task that an agent can carry out and is implemented as an object of a class that extends
jade.core.behaviours.Behaviour

Each class extending Behaviour must implement the action() method, that actually defines the
operations to be performed when the behaviour is in execution and the done () method (returns a
boolean value), that specifies whether or not a behaviour has completed and have to be removed

from the pool of behaviours an agent is carrying out.

Method Description Return value
action() Runs the behaviour. abstract void
done() Check if this behaviour is done. abstract boolean
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3.1.1 Agent lifecycle

setup ()

- Initializations
- Addition of initial behaviours

Agent has been killed
doDelete () method called)?2

YES

Highlighted in red the
methods that
programmers have to
implement

Get the next behaviour from the
pool of active behaviours

v

b.action()

- Agent “life” (execution of
l behaviours)

b.done()?

Remove currentBehaviour from
the pool of active behaviours

y
takeDown () \ - Clean-up operations

Agent Thread path of execution

e Agent lives until the method doDelete() is not called, even if pool of behaviours is empty.

e The only behaviour, which would return true by function done() are removed from the
pool

3.1.2 The Forgetful agent
Let's look to the agent's code.

e What can be returned by function done() in OneShotBehaviour? When it is going to be
removed from behaviour pool?

e What can be returned by function done() in CyclicBehaviour? When it is going to be
removed from behaviour pool?

Page 19 /22



What does it means for those behaviours?

What would be the output of the agent in your opinion?

Let's run the agent and check

Uncomment the line myAgent.addBehaviour(new SingleBehaviour()); in class
CyclicBehaviour2

Comment myAgent.addBehaviour(new SingleBehaviour()); inclass
CyclicBehaviourl

What is the output?

UML diagram of types of defined behaviours in JADE:

Behaviour
<abstract=> action -
0. <abstract>> done{}“ Models a generic
— nStart() task
nEnd()
lock()
estart()

Models a complex Dy
task i.e. a task that is : - Models a simple task AN - -
made up by CompositeBehaviour i e. a task that is not SimpleBehaviour
composing a number composed of sub-tasks
of other tasks. L’>
\
\
OneShotBehaviour CyclicBehaviour
Meodels an atomic Models a cyclic
\ task (its done() task (its done()
method returns true) method retums
false)
FSMBehaviour
SequentialBehaviour ParallelBehaviour
egisterState()
egisterTransition() [¥addSubBehaviour() [#addSubBehaviour()
Models a complex task Models a complex task Models a complex task
whose sub-tasks L whose sub-tasks are whose sub-tasks are
concsponds o heacies || cxeute sequentaly erected concureny
Finite State Machine

3.2 The Listener agent

Run the Listener Agent

Send do the running agent message: Actions ->Send Message
Check the processor usage

Add one more listener agent and check usage now
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e Check usage after killing them both softly
e Add the code below after the if-statement:

else {
block();

}

e How does the CPU usage looks now?

o Let'sadd to the else-statement at the end line:
System.out.println("Blocked.");

e When exactly the agent is being blocked?

3.3 The Talker agent
e Run the Listener agent
e Run the Talker agent adding in field Arguments name of the running Listener agent.
e Let's take a look into code of both agents. What types of arguments are being sent to the
Listener agent

3.4 Way of communication

One of the most important features that JADE agents provide is the ability to communicate
and interactions protocols. The communication paradigm adopted is the asynchronous message
passing. Each agent has a sort of mailbox (the agent message queue) where the JADE runtime posts
messages sent by other agents. Whenever a message is posted in the message queue the receiving
agent is notified. If and when the agent actually picks up the message from the message queue to
process it is completely up to the programmer however. All received messages are being hold in FIFO
gueue, but it is available mechanism to search in the queue with patterns. Messages are objects
containing lots of information and having many methods to help communicate (more details soon).

Get the message

Prepare the from the message
message to A2 T queue and process 1t

|

Send the message Post the message in
A2’s message queue

Distributed JADE runtime

The JADE asynchronous message passing paradigm

4 Exercise 2
e Run the PingPong agent
e Take alook to the source code of all tree agents: Ping, Pong, PingPong
o How they communicate?
e How new agents are being created? Who is their creator?
e What would happen (or rather not) if we don't call the start() method
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e Robert's tutorial in polish
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